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utility adjustment plans.  
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Chapter 1 
Installation Procedures    
 

OBJECTIVE 
The objective of this chapter is to outline the procedure for installing the FDOT2004 SiteMenu. 

INTRODUCTION 
The installation procedure for FDOT2004 SiteMenu is application specific.  The installation procedure for 
the following applications will be covered in this chapter: MicroStation V8, AutoCAD 2006, Autodesk 
Civil 3D, Autodesk Land Desktop, and Autodesk Map 3D.  One of these programs must be installed on the 
local machine before installing the FDOT 2004 SiteMenu.  

SUPPORTED APPLICATIONS 
The following applications are supported by FDOT for use with the FDOT2004 SiteMenu: 

• MicroStation V8 – v08.05.02.55 or v08.05.02.56 

• GEOPAK 2004 – v08.08.02.07 

• GEOPAK Civil Extension – v08.08.02.07 

• Autodesk Civil 3D 

• AutoCAD 2006 

• Autodesk Map 3D 

• Autodesk Land Desktop 

SYSTEM REQUIREMENTS 
• Windows XP 

• Microsoft Office 2000 or Higher 

• Internet Explorer 6.0 or Higher 

• .NET 

FDOT 2004 INSTALLATION 
The FDOT 2004 SiteMenu can be installed one of two ways: Server/Client or Stand-Alone Workstation 
(MS Installation Only).  Server/Client configuration is recommended for sites with multiple computers 
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(preferred method of installation).  The Stand-Alone Workstation configuration is recommended when a 
workstation does not have continuous access to a network, such as a laptop.  FDOT 2004 Site Menu 
software can be obtained through the FDOT ECSO site: http://www.dot.state.fl.us/ecso/downloads/.   

 

2004 SERVER 
In this configuration a FDOT2004 directory will be installed on a server where the client workstations will 
access the FDOT2004 SiteMenu.  Approximately 400 MB of free space is required to install the 2004 
Server. 

2004 CLIENT 
MicroStation workstations will be configured to read the SiteMenu from the Server and the Electronic 
Delivery software will be installed locally.  Approximately 100 MB of free disk space is required to install 
the 2004 Client. 

2004 WORKSTATION 
Approximately 500 MB of free space is required to install the 2004 Workstation which includes the 
MicroStation SiteMenu and the Electronic Delivery software. 

2004 UTILITIES 
This installation for AutoCAD users includes the four standard SiteMenu items and the Electronic Delivery 
software. 

SUPPORT APPS 
The following are support applications to compliment the SiteMenu.   
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GHOSTVIEW 
GhostView is a PostScript and PDF previewing, conversion, and printing application. 

.NET FRAMEWORK 
This application is needed for the FDOT2004 SiteMenu Data Exchange.  The installer must configure the 
.NET Framework to full intranet access (See Lab Exercise: Installations). 

V8 CONVERTER 
This application can be used to convert an entire project from MicroStation v7 file format to the 
MicroStation v8 file format.  FDOT specific conversion table is provided with the FDOT 2002 Server and 
WorkStation installation. 

TSCC CODEC 
This application enables users to view “Quick Clips” (Online Video Training) provided by the FDOT. 
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ROD REDUCTION 
You input station, offset, and rod height readings from fieldbooks to be exported into GEOPAK, CAiCE, or 
Multi-line software. 

INSTALLATION ORDER 
The following is the order in which the FDOT2004 SiteMenu is installed: 

1. Microsoft .NET Framework 

2. MicroStation or AutoCAD 

3. GEOPAK 2004 and/or Civil Extension 

4. FDOT2004 (Server/Client or Workshop) 

5. V8 Converter 

EXERCISE 1.1    .NET FRAMEWORK INSTALLATION 

.NET Framework must be installed on the local workstation in order for the SiteMenu to operate correctly.  
The .NET Framework installation software is located on the FDOT 2004 CD under the Support Apps menu 
button. 

1. Click on the .Net Framework button to begin installation. 
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2. Click Yes to install .NET on the workstation. 

 
3. Once the following dialog box closes, installation for .NET Framework is completed. 

 
4. Next, configure the security parameters for the .NET Framework to trust the FDOT2004 Server on 

the LAN.  To configure the .NET Framework, navigate to Start > Control Panel > Administrative 
Tools > Microsoft .NET Framework 1.1 Wizards.  Select Adjust .NET Security. 
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5. Select Make changes to this computer; then, choose Next >. 

 
6. Select Local Intranet; then, move the slide arrow to Full Trust as shown below. Select Next >. 
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7. The Local Intranet setting should be set on Full Trust, if it is not, select the Back button to make 
necessary changes.  Once completed, select the Finish button. 
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EXERCISE 1.2 2004 SERVER INSTALLATION 

Installing the FDOT 2004 Server will create a FDOT2004 directory containing the resources used by the 
FDOT workspaces to customize MicroStation for use on FDOT projects. 

1. Select the 2004 Server button to begin the installation process. 

 
2. Click Next > to continue with the installation. 
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3. Select the Browse button to define the location of the FDOT2004 folder.  Once the folder path has 
been defined click Next >. 

 
4. Next, the installation process allows you to backup existing FDOT 2004 files (recommended for 

those reinstalling FDOT2004 software).  If you select yes, the program will create a backup folder.  
Once you have made your selection, click Next >. 
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5. Select the directory location for the backup folder (if needed).  Click Next>. 

 
6. Click Next > to install the FDOT2004 Server. 
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7. Click Finish to complete the installation. 
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EXERCISE 1.3 2004 CLIENT INSTALLATION 

1. MicroStation workspaces will be installed and configured to read FDOT2004 SiteMenu and 
MicroStation resources from a server; Electronic Delivery software will be installed locally.  To 
begin the installation process, select the 2004 Client button. 

 
 
 

Warning: Before proceeding, previous versions of the FDOT’s Electronic Delivery software should be removed 
from the workstation.  This is done because you will be installing the most recent version of the 
Electronic Delivery software. 
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2. Click Next > to continue. 
 

 
 
 

3. Click Next >. 
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4. The following dialog defines all of the information necessary to configure MicroStation to use the 
FDOT2004 Site Menus.  Review and complete all requested fields.  Select Next > to continue. 

i. FDOT2004 Directory – Select Browse and define the local FDOT2004 directory path.  
Typically it is C:\FDOT2004\ and will be the default setting unless otherwise specified. 

ii. MicroStation Directory – Select Browse and define the path where the MicroStation 
executable file resides.  Typically the file is located C:\Program 
Files\Bentley\Program\MicroStation.  

iii. Projects Directory – Select Browse and define the path for the FDOT Projects Directory.  
Typically the directory is located C:\e\Projects. 

iv. CAiCE Directory – (If applicable) Select Browse and define the path for the executable file 
for CAiCE.  If CAiCE is not installed on the workstation place a Check in the box “CAiCE is 
not installed”. 
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v. The program will install configuration files and Electronic Delivery software onto the 
workstation.  Select Finish when the installation is completed. 
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EXERCISE 1.4 2004 WORKSTATION 

1. This is a complete installation of the FDOT2004 Site Menu and Electronic Delivery software.  
This installation is recommended for workstations that are not regularly connected to a server or 
where a server is unavailable.  To begin installation, select the 2004 Workstation button. 

 
 

Warning: Before proceeding, previous versions of the FDOT’s Electronic Delivery software should be removed 
from the workstation.  This is done because you will be installing the most recent version of the 
Electronic Delivery software. 
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2. Click Next > to proceed with the installation. 

 
3. Click Next >. 
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4. The following dialog defines all of the information necessary to configure MicroStation to use the 
FDOT2004 Site Menus.  Review and complete all requested fields.  Select Next > to continue. 

i. FDOT2004 Directory – Select Browse and define the local FDOT2004 directory path.  
Typically it is C:\FDOT2004\ and will be the default setting unless otherwise specified. 

ii.  MicroStation Directory – Select Browse and define the path where the MicroStation 
executable file resides.  Typically the file is located C:\Program 
Files\Bentley\Program\MicroStation. 

iii.  Projects Directory – Select Browse and define the path for the FDOT Projects Directory.  
Typically the directory is located C:\e\Projects. 

iv. CAiCE Directory – (If applicable) Select Browse and define the path for the executable file 
for CAiCE.  If CAiCE is not installed on the workstation place a Check in the box “CAiCE is 
not installed”. 
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5. Select Next > to install the FDOT files and programs. 

 
6. Click Finish to complete the installation. 
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EXERCISE 1.5 2004 UTILITIES MENU (AUTOCAD) INSTALLATION 

1. 2004 Utilities Site Menu is designed and configured for AutoCAD.  The installation process will 
load four standard menus and the Utility menu for AutoCAD.  Select the 2004 Utilities button to 
begin installation. 

 
2. When starting the installation, the program will search the registry for AutoCAD.  If AutoCAD is 

not found, a dialog box opens requesting the location of the AutoCAD execution file autocad.exe.  
Click Browse and specify the location of autocad.exe. Click OK. 
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3. Click Next > to continue. 

 
4. Click Next > to start the installation. 

 

1-22                                                                                    ©2006 FDOT Producing Utility Plans for FDOT 



Chapter 1   Installation Procedures 

 

5. Click Finish to complete the installation. 
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Chapter 2 
FDOT2004 Site Utilities    
 

OBJECTIVE 
The objective of this chapter is to review FDOT2004 SiteMenu. 

MICROSTATION ENVIRONMENT 
FDOT uses a workspace to setup its MicroStation environment.  A workspace is a customized MicroStation 
work environment that uses specific support files, defines configuration variables and sets paths.  The 
FDOT2004 Workspace also defines the location of the projects and creates the standard project directory 
structure.  Many of the FDOT2004 programs and supporting files are dependent on GEOPAK being 
activated, or as a minimum, the Civil Engineering Extension that is available with MicroStation. 

The FDOT2004 workspace is made up of two parts: the User Configuration and the Project Configuration. 

By selecting the Workspace FDOT2004, the configuration FDOT2004.ucf is accessed.  This file then calls 
two other files: sitefdot.txt (which sets all of the standard variables) and utilities.txt (which sets the utility 
specific variables).  These configuration files define the location of level libraries, cell libraries, conversion 
files, seed files and many other types of files. 

In addition to the User configuration file there is a Project configuration file.  This file defines the Financial 
Project Identification Number and the location of the project files. 

To open MicroStation, using the FDOT2004 customized features, double click on the FDOT2004 folder 
located on the workstation’s desktop.  When opened, double click on the FDOT2004 MicroStation icon.  
This procedure is the only way you should access MicroStation.  Select the appropriate project or create a 
new one. 

Note: To prevent users from accessing MicroStation the incorrect way, replace the standard 
MicroStation icon on the workstation’s desktop with the FDOT2004 icon located in the 
FDOT2004 folder. 

Warning: DO NOT DOUBLE CLICK MICROSTATION FILES IN EXPLORER TO OPEN FILES. Always 
access MicroStation by the procedure noted above. 

FDOT2004 Desktop Folder 
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FDOT2004 Desktop folder contains shortcuts to accessing all files. 
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CONFIGURING MICROSTATION FOR UTILITY MENU 
When FDOT 2004 SiteMenu is initially installed on a workstation, the FDOT Utility tools are not loaded.  
To load the FDOT2004 Utility tools, click on FDOT2004 SiteMenu box and navigate to the Standard menu 
pull down.  From the Standard pull down, select SiteMenu Configuration.  Select the radio button next to 
Standard Plus Utilities Menu; then, click Update.  A dialog box will open noting that the MicroStation .UCF 
has been rewritten; click OK to accept the changes.  Once SiteMenu restarts, the workstation’s screen 
appears as follows: 

 

AUTOCAD ENVIRONMENT 
FDOT uses a profile to setup its AutoCAD environment.  A profile customizes the support file, and the 
working support file searches paths in AutoCAD.  FDOT redirects the paths to point to the FDOT2004 
folder that was previously installed (see Chapter 1).  During installation of FDOT2004 for AutoCAD, an 
icon was created on the workstations desktop to access FDOT2004 SiteMenu in AutoCAD.  To access 
FDOT2004 SiteMenu, double click the icon. 

Note: Always open AutoCAD using the following icon to access FDOT2004 SiteMenu 
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AutoCAD with FDOT2004 SiteMenu loaded appears as follows: 

 
AutoCAD Support Paths – To avoid using the full path when calling AutoCAD resources from SiteMenu 
content files (MNU, LST, etc.), a support path must be added to the AutoCAD session.  This is 
accomplished by creating an FDOT AutoCAD profile.  The profile is then loaded by setting the icon 
parameter, /p, as an argument to the target in the AutoCAD icon properties.  Additionally, a script file, /b, is 
automatically loaded (a SiteMenu ARX file) as a parameter in the AutoCAD icon properties.  This setup 
will be part of the FDOT2004 installation option for Utilities.  The installation program will copy the 
appropriate files to the local machine, and icons will be created in the FDOT2004 Start Menu. 

FDOT2004 UTILITY MENU 
 

FDOT2004 Utility Menu allows users to access CAD standards and design tools for utility design through 
file pulldown menus, hotlists, and hot boxes. The Set utility pulldown menu allows users to access design 
tools for various utilities.  The Drawing Scale pulldown menu allows the user to specify annotation scale of 
the design file.  The Annotation-Util pulldown menu gives the user access to the utility border cell, 
standard text templates, and dimensioning tool. 

FILE 
The file pulldown allows the user to access the Create/Edit command.  The Create/Edit command enables 
the user to generate utility design files based on FDOT standards. 
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SET UTILITY MENU 
The Set Utility menu contains the FDOT design standards for the utilities listed.  Upon selecting a utility a 
dialog box called a hotlist will open. 

 

DRAWING SCALE 
Drawing scale sets the active scale of the design file for placement of cells and text. 
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ANNOTATION-UTIL  
Annotation-Util is used for placing text into the design file, according to FDOT standards.  It also enables 
the user to place standard drawing border and dimensions in a design file.  Select the function that you want 
to place in the design file and a template will open for placing the text, border, or dimension. 

 

TOOLS 
The Tools Menu allows the users to Load or Unload the Markup Utility Tool.  The Markup Utility Tool 
automates the Red, Brown, Green markup process, covered in Chapter 9.  The first icon in the Markup 
Utility, allows the user to toggle between the standard MicroStation view and the Red, Brown, Green 
markup view.  The Green, Red, and Brown buttons enable the user to change the attributes for placed utility 
lines while in the Markup view.  The lock icon deselects items that are tagged as a Red, Brown, or Green 
item.  The last icon on the right, allows the user to change the color and line weight of the Red, Brown, 
Green attributes. 

 

 

HOTLISTS 
HotLists are a list of commands that are organized in list form to simplify the procedure of accessing 
different utility standards for design.  Set Utility is the default tab when you open a hotlist.  The Set Utility 
tab allows the user to navigate through all of the utilities available for design by FDOT standards.  The 
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Drawing Scale and the Annotation-Util can also be accessed in the hotlist for each selected utility.  The 
remaining two tabs house the tools used to draw-in the existing and proposed utilities.  To execute the 
commands, select the list item that you plan to perform. 

 

HOT BOXES 
Hot Boxes are icons that can be assigned to execute commands specified by the user.  MicroStation Hot 
Boxes can be assigned to execute the following functions: key-in commands, tool boxes, tool frames, 
views, dialogs, MDLs, macros, HotLists, or the Site Menu browser.  AutoCAD Hot Boxes can be assigned 
to execute HotLists and the SiteMenu browser.  Hot Box icons can be moved and resized by dragging 
anywhere on the Windows desktop. 
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Chapter 3 
Data Exchange 
 

INTRODUCTION 
The purpose of this chapter is to outline the process and procedure for exchanging data between the FDOT 
District Offices and the Utility Agency/Owner (UAO).  

FDOT COMMITMENT 
The FDOT will provide tools, training and information to Utility Companies in several areas of electronic 
data usage and exchange.  In an effort to improve the exchange of data between FDOT and Utility 
Companies, FDOT has: 

 Revised the CADD Standards for MicroStation 2004. 

 Provided information for migrating existing non standard electronic files to the FDOT 2004 
standards. 

 Created new FDOT programs and menus to assist the UAO or consultant in the production of 
Utility Plans in accordance with the FDOT2004 standards. 

BENEFITS OF SITEMENU 
Coordinating the sharing of data between the districts and the Utility Companies is advantageous to both 
parties.  Some of the benefits are:  

 Increased accuracy (no longer a hand-drawn markup of construction drawings). 

 Reduction in liability (the utility owner is responsible for the placing of their facility, while 
FDOT is responsible for its roadway construction document). 

 Reduction in work effort (no longer is redundant data being placed as markups on several sets 
of plans). 

 Reduction in paper (reproduction issue of phases construction sets). 

 Provides UAO access to FDOT resources (cells, lines, etc.); both parties are using the same 
standard sources. 

 Access to the FDOT graphic files (this allows the UAO to use the project data as AS-Builts 
for later design). 

UTILITY COORDINATION WORKFLOW 
The following four flowcharts outline the procedures for exchanging data with FDOT District Utilities 
Office.  The flowcharts describe what information is to be transmitted from the Designer to the FDOT 
District Utilities Office to the UAO and back.  These flowcharts are intended for Standard Design 
coordination procedures and not for Design-Build contracts. 
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Phase I Utility Coordination Workflow outlines the procedure for the initial project setup and establishing 
the location of existing utilities.  The FDOT District Utilities Office is the coordinator for all information 
for a project between the Designer and the UAO.  The Designer in Phase I will establish the proposed 
working plans and scope of work for the roadway plan set.  The Designer will then submit the existing plan 
set to the FDOT District Utilities Office to be distributed to the UAO.  Once the UAO has received the 
existing plans and scope from the FDOT District Utilities Office, the UAO is responsible for transferring 
the existing utility data onto the plans provided by FDOT District Utilities Office.  The FDOT District 
Utilities Office will transmit all design files in DGN or DWG format.  The plans provided to the UAO from 
the FDOT District Utilities Office are to be Referenced/XREF into their own utility plan.  The UAO is not 
permitted to change any information in the plans provided by the FDOT District Utilities Office.  The UAO 
is to inform FDOT District Utilities Office if optional data transfer methods such as PDF, ASCII, or 
LandXML format is required.  When the UAO has completed the existing utility plans, they are to submit 
the plans to the FDOT District Utilities Office.  Once FDOT District Utilities Office receives the existing 
utility plans, a Pre-Design Meeting will be scheduled with the Designer and the UAO.  On completion of 
the meeting, the FDOT District Utilities Office will distribute the existing utility plans to the Designer. 
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Phase II Utility Coordination focuses on the proposed design of both the roadway and utility plans.  On 
completion of the roadway plans, the Designer will contact the FDOT District Utilities Office.  The FDOT 
District Utilities Office will then contact the UAO and transmit the proposed roadway plans.  The UAO 
will Reference/XREF the roadway plans into their proposed utility plans.  Once completed with the 
proposed utility plans, the UAO must complete Section A of the Utility Work Schedule and submit both 
Section A and the proposed utility plans to the FDOT District Utilities Office.  The FDOT District Utilities 
Office will hold a Design Meeting to review the plans and discuss any scheduling or design issues 
encountered.  After the design meeting, the FDOT District Utilities Office will distribute the proposed 
utility plans to the Designer. 
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PHASE III UTILITY COORDINATION WORKFLOW 

 

Phase III Utility Coordination process is a review process of the utility and roadway plan.  Once the 
Designer has completed all of the roadway plans for the project, the Designer will transmit the plans to the 
FDOT District Utilities Office.  After receiving the plans, the FDOT District Utilities Office will contact 
the UAO and transmit the final plans.  The UAO will Reference/XREF all of the roadway plans and review 
for any conflicts.  The UAO is required to provide two originals and two copies for an aggregate of four 
sets of plans of the Utility Relocation Schedule.  The FDOT District Utilities Office will hold a Pre-Design 
Meeting to review and discuss any utility work issues.  The FDOT District Utilities Office will submit the 
final utility plans to the Designer. 
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PHASE IV UTILITY COORDINATION WORKFLOW 

 
Phase IV Utility Coordination is the process of reviewing and revising the final construction documents.  
The Designer will submit the final roadway plans to the FDOT District Utilities Office to be distributed to 
the UAO.  Once the UAO receives the roadway plans, they are to review all the plans for accuracy and 
resubmit to the FDOT District Utilities Office noting any required revisions.  The FDOT District Utilities 
Office will then review the plans for conflicts and will contact the necessary agents of required changes.  
Once the plans have been corrected, the FDOT District Utilities Office will submit the drawings to the 
Designer. 

UTILITY COORDINATION OPTIONS 
FDOT accepts three separate methods for data exchange:  

 MicroStation (DGN) or AutoCAD (DWG) design files (preferred method) 

 ASCII Input file (Station/Offset or Northing/Easting) 

 PDF file 

 Geographic Information System (GIS) File 

SHARING OF GRAPHIC FILES 
FDOT will supply the UAO with MicroStation or AutoCAD files for a base reference for the project.  The 
UAO is to Reference/XREF the files provided by FDOT to their design file (changes to the original files 
from FDOT by the UAO will not be accepted) and insert their utilities into the new design file.  The UAO 
will receive the following base files from the FDOT District Utilities Office: the existing topography, the 
existing and proposed ROW, and the existing survey. 
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ASCII INPUT FILE 
ASCII input files containing the Station/Offset or Northing/Easting location of existing or proposed utilities 
are accepted by FDOT for data transfer.  The ASCII files will contain all information pertaining to the 
location of the utility in reference to a baseline (provided by FDOT) or state plane coordinates, and contain 
all pertinent information for that particular utility.  The following are examples of acceptable ASCII file 
formats: 

Northing/Easting (N/E) - The Northing/Easting ASCII file will conform to the State Plane Coordinates of 
Florida.  In order to generate an ASCII file, users must define points and chains within the file.  See 
Chapter 19 of the FDOT CADD Production Criteria Handbook for file generation. 

Station/Offset – This method requires the user to define the location of a utility by designating the station 
and offset points from a defined baseline.  The baseline will be provided by the FDOT District Utilities 
Office on request from the UAO.  Refer to Chapter 19 of the FDOT CADD Production Criteria Handbook 
for file generation. 

PDF 
PDF files are an acceptable method for utility coordination.  The UAO must contact the FDOT District 
Utilities Office if this method is desired.  After receiving the PDF file from the FDOT District Utilities 
Office, the UAO must review and identify the location of their utilities incorporating the Green, Red, 
Brown method.  

Green: Existing utility facilities to remain in place with no adjustment. 

Red: Existing utility facilities to be removed or relocated horizontally to some other location, or existing 
facilities to be Placed Out Of Service (Deactivated) but left in place. 

Brown: Existing utility facilities that are to be adjusted vertically but to remain in the same horizontal 
alignment or completely new facilities to be installed. 

Note: In addition to the color code, the limits of the facilities to be removed, relocated, adjusted, or 
placed out of service (deactivated) shall be delineated. If the work is associated with an 
FDOT construction project, utility delineation will be shown by station. 

These methods may be used in coordination with the ASCII file method. 

GEOGRAPHIC INFORMATION SYSTEM (GIS) 
In the event that a utility company maintains a GIS database of utility data and would make it available for 
use, this data can be imported into MicroStation.  The MicroStation’s Geographic’s software allows the 
user to import GIS shape files into a DGN file.  The imported elements maintain the database information 
allowing text annotation and resymbolization by a specific query or criteria. 

EXERCISE 3.1 – CREATING AN ASCII FILE 

ASCII Generation (GEOPAK) 

1. Open the MicroStation file C:\e\Projects\9638527\utils\blsr5.dgn. 
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2. Open the GEOPAK Coordinate Geometry job Utl. (MS: Applications > GEOPAK Road > 
Geometry > Coordinate Geometry). 

 
3. Access the Export ASCII Points tool. (Cogo: File > Export > ASCII Points). 

 
4. Create the Output File C:\e\Projects\9638527\utils\baseline.txt. 

5. Match the following Output Format for the ASCII file. 
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6. Highlight points 1-3; then, click Apply to create the ASCII file. 

7. Open the ASCII file C:\e\Projects\9638527\utils\baseline.txt using Notepad. 
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Chapter 4  
Utility Plan Development 
INTRODUCTION 

The objective of this chapter is to demonstrate the process of generating a utility plan sheet and referencing 
Roadway plans provided by FDOT. 

UTILITY PLAN GENERATION 
There are two distinct ways of creating the utility plan sheet:  

1. Use the Create Edit FDOT2004 Files in the FDOT2004 Menu. 

2. Save the drawings provided by the FDOT District Utilities Office to different files. (This method 
will retain the standard level libraries and references.) 

The Create Edit FDOT2004 Files option will automatically generate the utility files required by the 
FDOT District Utilities Office.  The Create Edit FDOT2004 Files is a program that runs both external to 
and internal with MicroStation.  The program uses an ASCII file (*.ctl) to create MicroStation and 
AutoCAD design files.  The program creates the files with the correct naming standards and seed files.  
Additionally, the Create Edit program attaches the FDOT Standard Level Library to the file. The Create 
Edit command can be found in the FDOT2004 folder located on the desktop or in the FDOT2004 Utilities 
File Pulldown.  
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STANDARD UTILITY FILE NAMES 
The following table defines the naming standards for FDOT projects with regard to Utility Plans.  If the 
Utility work is accomplished by a highway contractor as a separate contract (UWHC plans), the discipline 
designation for the file name is UW.  For example, a utility adjustment file name would be utaduw01.dgn.  
If the utility adjustments are included in the Roadway plan set, the discipline designation for the file name 
is RD.  For example, a utility adjustment file name would be utadrd01.dgn.  Refer to Chapter 13 in the 
CPCH for the standard Utility file names defined for use by Roadway Design. 

 

STANDARD ROADWAY FILE NAMES 
The following are a list of standard Roadway files that a UAO may receive from the FDOT District 
Utilities Office during a project. 

 

FILE REFERENCE 
The FDOT Designer will supply the Utility Agency/Owner (UAO) with the existing topography and survey 
files prior to project startup.  The files that are delivered to the UAO will be in MicroStation DGN format.  
It is possible for FDOT to distribute the drawings in DWG format; however, prior arrangements need to be 
made with the FDOT District Utilities Office.   
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Once the UAO has received the plans from the FDOT District Utilities Office, they must reference the 
drawings into their own design files.  To accomplish this, the UAO Designer must access Reference 
Manager via File > Reference.   

 
To attach the files, the UAO Designer must navigate to Tools > Attach.  A dialog box will open requiring 
the Designer to choose the file to be attached.  After selecting a file to attach to the design file, the Designer 
must set the attachment parameters for the file.  Use the following figure as a template for the Reference 
Attachment Settings: 

 
Note: Orientation method must be set to Coincident World; True Scale should be checked.  Coincident 

World aligns the reference with the active model with regard to both the Global Origin and design 
plane coordinates.  True Scale aligns the units of measurement for both the design file and the attached 
file one to one. 
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EXERCISE 4.1: UTILITY FILE GENERATION 

CREATE UTILITY DESIGN FILE – CREATE EDIT/PROJECT (DGN OR DWG) 

1. From the FDOT2004 desktop folder, double click on the Create Edit FDOT2004 Files 
shortcut.  

  
2. Click on Project Settings to define the current project. 
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3. Click on Select Active Project.  Select Browse for the Active Project and navigate to 
C:\e\Projects\4035981.  Select Browse for the Default Folder and select the Utils folder.  
Click OK. 

 
4. Click OK in the Project Settings dialog.  Click the File Group down arrow and Select Utilities 

Design Files (DGN or DWG). 

 
5. Select UWHC Utilities – Existing then Click Create.  A dialog box will open stating that the file 

has been created successfully. 

6. Repeat step 5, but Select UWHC Utilities – Proposed. 

 

4-6                                                                                    ©2006 FDOT Producing Utility Plans for FDOT 



Chapter 4 Utility Plan Development 

EXERCISE 4.2: FILE REFERENCING 

REFERENCING FILES INTO MICROSTATION 

1. Open the existing utilities design file C:\e\Projects\4035981\utils\UTEXUW01.dgn. 

2. On the MicroStation File menu, select Reference. 

 
3. Select Tools > Attach, and navigate to C:\e\Projects\4035981\utils\blsr5.dgn.  Under 

Attachment Method, Select Coincident World.   

4. Click OK. 

 
5. The Roadway Plan file is now referenced into the Existing Utilities design file.  Click the Fit 

View to see the attachment. 

6. Repeat step 3 to attach the Roadway Topography file topord01.dgn. 

XREF FILES INTO AUTOCAD 

1. Open the Existing Utilities design file C:\e\Projects\4035981\utils\UTEXUW01.dwg. 

2. Open XREF Manager by entering XREF in the AutoCAD Command prompt; then, select 
Enter. 
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3. Click Attach and navigate to E:\e\Projects\4035981\utils\blsr5.dwg; then, click Open.  

4. Select the External Reference dialog settings as follows; then, click OK. 

 
5. Repeat steps 3 and 4 to attach topord01.dwg. 

6. Click Zoom Extents to view the XREF files. 
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Chapter 5 
Utility Plan Generation 
 
CHAPTER OBJECTIVES 

The objective of this chapter is to: 

 Learn how to create an existing Utility Plan using the Site Utilities Menu. 

 Review labeling procedures for Utility Plans. 

INTRODUCTION 

FDOT2004 Site Utilities Menu allows the user to design existing and proposed Utility Plans conforming to 
FDOT standards.  The use of Hotlists and Hot Boxes aid users by organizing utility cells, line styles, and 
text for each utility into a central location.  

DRAWING SCALE 

When generating a Utility Plan for the first time, the user must set the Drawing Scale for the design file.  
Setting the Drawing Scale enables FDOT2004 Utilities Menu to place cells, line styles, and text at the 
appropriate size.  To set the Drawing Scale, navigate to the FDOT Utilities Menu and select the Drawing 
Scale menu.  

 

SET UTILITY 

The Set Utility command allows the user to specify which Utility is to be created in the design file.  By 
selecting a Utility on the Set Utility menu, a Hotlist is activated.  Within the Hotlist, a series of tabs will 
allow the user to select existing or proposed tools for placing cells and line work.  The cells and line 
attributes for each line are set via cell (\FDOT2004\Standards\cell\syeng.cel) and resource files 
(\FDOT2004\Standards\symb\utilities.rsc). 
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To execute a Hotlist, the user clicks the Set Utility menu and selects the Utility that is to be placed in the 
design file. 

 
The Utility Hotlist distinguishes the Existing and the Proposed design tools by placing an E or a P prefix on 
the Utility name. 
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PLACING UTILITIES 

When placing Utilities, in the Hotlist the user will select the function desired. The application will 
automatically start. 

 
Note: Notice the active level and line attributes; how they change when a Utility Item is selected. 
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LEVEL NAMING FORMAT 

FDOT has generated standard Level Libraries that are attached to the Hotlist commands in the Utilities 
Menu.  When a utility tool is selected from a Hotlist or Hot Box, the standard levels are automatically 
imported.  Generally the naming of utilities is self explanatory, that is, the level name Gas refers to Gas 
line, Sanitary Sewer is Sanitary Sewer, etc.  FDOT attaches suffixes to the Level Names to differentiate 
between proposed and existing utilities, as well as the sheet where the level resides.  The following are a 
list of the suffixes that are used: 
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FDOT has included standard line styles with the FDOT 2004 SiteMenu.  The following are typical line 
styles used by FDOT for utilities. 
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UTILITY LABELING 

The Annotation-Util menu on the FDOT2004 Utilities Menu assists users in setting the text attributes to the 
FDOT Standards.  When generating the labels, users will select the type of text they want to place in the 
design file: either plan or detail text.  The plan text will be used when inserting standard utility labels in the 
design file, and the detail text will be used for placing all notes and detail text. 

 
The following is a template to be used for labeling utilities in the Utility sheets:  

 
Type of Utility - Labels the Size, Material, and Type of Utility  

Utility Disposition –Modification to the Utility labeled, i.e. To Remain, Proposed, etc.  Do not label a 
Utility with Abandoned; label the utility as Out of Service.  If the Utility Disposition is To Remain; 
disregard the Method of Placement call out. 

Utility Owner – The Utility Owner is to be labeled using a two letter code.  The code must be placed 
in a key located on the first Utility Drawing.   

Placement Responsibility – Which Agency will cover the work in their Contract. 

The following are some examples of Standard Utility Labels: 
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LABELING STRUCTURES 

UAO’s are responsible for designating all utility structures in the plan design.  All existing and proposed 
structures are to be displayed and labeled as follows: 

Circle – A circle is to be placed in the location of all non concrete items such as valves, meters, 
popoffs, etc.  The circle shall be large enough to place a three digit number to catalog each item. 

 
Square – A square is to be placed in the location of all concrete items such as manholes, vaults, pull 
boxes, etc.  The square shall be large enough to place a three digit number to catalog each item. 

 
The circle/square line type shall be dashed for existing utilities and solid for proposed utilities.  UAO’s 
will need to generate a catalog referencing the structure number, location (station and offset), type, size 
(external dimensions), and name of owner.  

PROFILE LABELING 

The UAO’s are responsible for labeling their utility crossings in the Drainage profile sheets provided by 
FDOT.  For circular utility lines, an ellipse shall be placed at the correct invert in the Drainage profile sheet 
and labeled.  Box utilities shall be placed, to scale, in the Drainage profile sheet and labeled.  Show existing 
utilities as a dashed line, and use a solid line for proposed utility lines. 

EXERCISE 5.1: UTILITY PLAN GENERATION 

GENERATE UTILITY PLAN SHEET (MICROSTATION) 

1. Open the MicroStation file C:\e\Projects\9638527\utils\UTEXUW01.dgn. 

2. Open the MicroStation Saved view Electric. (MS: Utilities > Saved Views) 
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3. Open the Electric Hotlist. (FDOT Utilities Menu: Set Utility > Electric) 
 

 
4. Select the E_Electric tab.  Click on Power Lines (Aerial) to place over head power lines. (Electric 

Hotlist: E_Electric > Conductors > Power Lines (Aerial)) 

5. Snap to the center of Power Pole No.1; then, left click to accept.  Snap to the center of Power Pole 
No. 2; then, left click to accept. 
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6. Continue connecting Power Poles Nos. 3-5. 

 
 

GENERATE UTILITY PLAN SHEET (AUTOCAD) 

1. Open AutoCAD file C:\e\Projects\9638527\utils\UTEXUW01.dwg. 

2. Open AutoCAD Named View Electric.  (AutoCAD File Menu: View > Named View) 
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3. Open the Electric Hotlist. (FDOT Utilities Menu: Set Utility > Electric) 

 
4. Select the E_Electric tab.  Click on Power Lines (Aerial) to place over head power lines. (Electric 

Hotlist: E_Electric > Conductors > Power Lines (Aerial)) 

5. Snap to the center of Power Pole No.1; then, left click to accept.  Snap to the center of Power Pole 
No. 2; then, left click to accept. 
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6. Continue connecting Power Poles No. 3-5. 

 
 
 

EXERCISE 5.2: UTILITY LABELING 

UTILITY LABELING FOR MICROSTATION 

1. Open MicroStation file C:\e\Projects\9638527\utils\UTEXUW01.dgn. 

2. Open the MicroStation Saved View Electric. (MS: Utilities > Saved Views) 
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3. Open the Plan TXT command from the Annotation-Util file menu. (FDOT Utilities Menu: 
Annotation-Util > Plan TXT)  

 
4. Enter the following information into the Text Editor Window: 138 KV OE / TO REMAIN (Select 

Enter), FP.  Place the text into the design file. 

Note: The 138 KV is the capacity of the utility line, OE is the abbreviation for Overhead Electric, To 
Remain is the Disposition, and FP is the two letter code for Florida Power. 

 
5. Open MicroStation Drafting Tools to place a leader from the utility label to the utility line. (MS: 

Tools > Annotation > Drafting Tools) 

 
6. Select Place Leader and Text button (second from the left). 
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7. Snap to the midpoint of the OE line connecting PP No.1 and PP No.2; then, Left Click to accept.  
Move the cursor to the utility label, place a second point for the leader; then, left click to accept 
location. 

 
8. Open the Extend MS Element tool.  Extend the end point of the leader through the utility label. 

 

 
9. Repeat steps 3-8 to label the remaining utility lines. 
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UTILITY LABELING FOR AUTOCAD 

1. Open AutoCAD file C:\e\Projects\9638527\utils\UTEXUW01.dwg. 

2. Open the Plan TXT command from the Annotation-Util file menu. (FDOT Utilities Menu: 
Annotation-Util > Plan TXT) 

 
3. Enter the following information into the Text Editor Window: 138 KV OE / TO REMAIN (Select 

Enter), FP.  Place the text into the design file. 

Note: The 138 KV is the capacity of the utility line, OE is the abbreviation for Overhead Electric, To 
Remain is the Disposition, and FP is the two letter code for Florida Power. 

 
4. Open the AutoCAD Leader tool. (AutoCAD Menu: Dimension > Leader) 
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5. Snap to the midpoint of the OE Line going from PP No.1 to PP No.2; then, left click to begin 
drawing the leader.  Move the cursor and place the second point of the leader between the two 
lines of text for the Utility Label; then, left click to accept.  Finally, move the cursor between the 
two lines of text to make a delimiter; then, left click to accept. 

 
6. Repeat steps 3-9 to label the remaining utility lines. 
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Chapter 6 
Phase I - Data Exchange 

 

INTRODUCTION 
The objective of this chapter is to discuss the procedure for transferring utility plans to the FDOT District 
Utilities Office. 

ELECTRONIC DATA TRANSFER 
The FDOT utilizes a FTP (File Transfer Protocol) site to transfer files via the internet from the Utility 
Agency/Owner (UAO) to the FDOT District Utilities Office.  The FDOT District Utilities Office will 
notify the UAO of the FTP site that is to be used for the file transfer.  The UAO is to use the FTP site to 
transfer all pertinent files per the current phase of the project i.e. Phase I:  the UAO will transfer their 
UTEXUW01.dgn file to the FDOT Utilities District Office. 

DATA TRANSFER 
Phase I of the Utility Workflow requires the UAO to supply the FDOT District Utilities Office with an 
existing utility plan for the Roadway project. The file that is to be transferred to the FDOT District Utilities 
Office is the UTEXUW01.dgn design file. Before the UTEXUW01.dgn design file is sent to the FDOT 
District Utilities Office, the UAO is required to detach all reference files attached to the existing utilities 
design file. 

Note: Inform the FDOT District Utilities Office if information besides a CADD file will be transmitted. 

DETACH REFERENCE FILES 
Detaching all of the reference files attached to the UTEXUW01.dgn ensures that all information pertaining 
to the existing utilities will be conveyed to the FDOT. This procedure is also necessary so that the FDOT 
District Utilities Office can create a master UTEXUW01.dgn containing all of the utilities for the project 
without having orphaned or circle references. 
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The MicroStation Reference dialog box enables designers to detach referenced files.  The MicroStation 
Reference dialog box is located on the MicroStation File menu. 
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The Reference dialog box displays all referenced files to the current design file. Detaching the referenced 
files requires the user to select the Tools menu and choosing Detach All. 
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Chapter 7 
Phase I – FDOT Review 

 

INTRODUCTION 

The objective of this chapter is to discuss the procedure for the FDOT to import the existing utility data 
provided by the Utility Agency/Owner (UAO). 

EXISTING UTILITY DATA 

The UAOs will submit the existing utility information to the FDOT District Utilities Office.  After receiving the 
information, the FDOT will generate a master utility file containing all of the applicable utilities for the project.  
The name of the master file, that the FDOT will generate, is UTEXRD01.dgn.  The FDOT will receive the 
existing utility information for the project in the one of the following ways: 

 MicroStation or AutoCAD design File 

 ASCII File 

 LandXML File 

 Geographic Information System (GIS) File 

MICROSTATION / AUTOCAD FILES 

After receiving the DGN or DWG files from the UAOs, the Designer will Reference the existing utilities files 
into a master UTEXRD01.dgn design file.   When referencing the existing utility file to the design file, the 
Designer must attach the file by global origin.  Referencing by global origin sets the design unit and coordinate 
origin the same as the design file that it is being referenced to.  Once the utility information is referenced into 
the master design file, the Designer must review the design files for conflicts.  

ACSII INPUT FILES 

ASCII input files are an alternate form of conveying utility information to the FDOT District Utilities Office.  
The ASCII file contains point and chain information for the utility line.  GEOPAK Coordinate Geometry 
processes the ASCII files provided by the UAOs, and will graphically display the points and chains in the 
design file. 
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 In order to process the ASCII file, the user must open GEOPAK Coordinate Geometry.  

 
Before the ASCII file can be processed, the user must rename the ASCII file.  The ASCII file provided by the 
UAO will be named utilex01.inp or similar.  The user must rename the ASCII file to conform to the following 
format: fname###.ioc.  The fname refers to the file name, ### is the GEOPAK Cogo job number, and oc is the 
users operator code (usually the users initials).  For example, the ASCII file utilex01.inp will be renamed 
utilexjob.ijd.   

Once the ASCII file has been renamed to conform to the naming standard, the user will be able to import the 
ASCII file into Cogo.  The Cogo File Utility tool will be used to import the UAO’s ASCII file. The File Utility 
tool is located on the Cogo File menu. 
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The ASCII file can now be loaded into Cogo by selecting the file; then, clicking Apply.  After executing the File 
Utility Load command, the information within the ASCII file will be imported into the Cogo display screen. 

 
Now that the ASCII information is in the Cogo display screen, process the commands from the ASCII file.  The 
Read All command will process the information contained in the Cogo display screen.  The Read All command 
is located on the Cogo Edit menu.  Once the Read All command is executed, the commands in the Cogo 
display screen will be stored into GEOPAK and the design file. 

LANDXML FILES 

UAO’s may choose to send LandXML files containing their utility information.  A LandXML file will have the 
file extension xml.  To import the LandXML file into the design file, the Designer must access the Import 
LandXML 1.0 dialog.  To access the Import LandXML 1.0 dialog, the user must open a GEOPAK 
Coordinate Geometry job.  Once Cogo is open, the user can access the Import LandXML 1.0 dialog by 
choosing the File menu and selecting Import LandXML 1.0 Geometry.   

 
The Import LandXML 1.0 dialog allows the user to import points, chains, or profiles.  Toggle On the 
appropriate file and items that are to be imported into the design file; then, select Import. 

GEOGRAPHIC INFORMATION SYSTEM (GIS) FILE 

UAO’s that utilize GIS database systems have the option of exporting shape files of their utilities for the project 
area.  MicroStation’s Geographic’s software allows users to import GIS shape files and maintain the original 
element information while placing the information into a utility design DGN file.   
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FDOT Data Transfer 
 

INTRODUCTION 

The objective of this chapter is to discuss the method of creating a PDF and the files that are to be transmitted to 
the Utility Agency/Owner (UAO). 

DATA TRANSFER 

The FDOT District Utilities Office is responsible for providing the UAO with the following files: 

 Existing Utilities Design File 

 Existing Topography Design File 

 Proposed Roadway Design File  

 Existing and Proposed Drainage Design File 

 Existing and Proposed Right-of-Way Design File 

MASTER UTILITY EXISTING UTILITIES FILE 

The FDOT District Utilities Office will provide the UAO with a master utility file, UTEXRD01.dgn, combining 
all of the utilities for the project.  The FDOT District Utilities Office will distribute this file to all the UAO’s for 
review before it is finalized.  Each UAO is responsible for reviewing the location of their utility lines in the 
master utility design file and notify the FDOT District Utilities Office of any revisions.  The master utility file 
will be distributed as a DGN, DWG, or PDF to each UAO.   

CREATING A PDF 

MicroStation V8 Print display screen allows users to select PDF generation as an option.  MicroStation V8 
comes standard with the necessary printer driver necessary to create a PDF.  The PDF printer driver is located, 
by default, in C:\Program Files\Bentley\Workspace\system\plotdrv\pdf.plt.  The following options can be set 
within the PDF printer driver: Bookmarks, References and Levels, Engineering Links, PDF Version, and 
Password Protection.   
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In order to generate a PDF of the design file, users must open the MicroStation Print tool.  With the Print tool 
activated the printer must be set to Bentley Driver. 

 
Clicking on the spyglass next to Bentley Driver will activate the Print Driver selection dialog box.  
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With the PDF printer driver loaded, users will execute the print command.  Once the print command has been 
executed, the user will need to specify the location of the PDF. 

 
EXERCISE 8.1: PDF 

GENERATE A PDF - MICROSTATION 

1. Open the MicroStation file C:\e\Projects\9638527\utils\planrd.FUCC.dgn. 

2. Activate the MicroStation Place Fence tool; then, place a fence around the plan sheet. 

3. Open the MicroStation Print dialog box. (MS: File > Print) 

 
4. Click Select Printer Driver spyglass to the right of the Bentley Driver. 

5. Open pdf.plt plot driver located C:\Program Files\Bentley\Workspace\system\plotdrv\pdf.plt. 

6. Select the Print icon to create the PDF. 

7. Name the PDF UTADRD01.pdf and place the file in the following folder:   
C:\e\Projects\9638527\utils\UTADRD01.pdf. Click OK. 
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8. Open UTADRD01.pdf and review the plot. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Chapter 8   FDOT Data Transfer 

 

8-6                                                                                    ©2006 FDOT Producing Utility Plans for FDOT 

GENERATE A PDF – AUTOCAD 

1. Open the AutoCAD file C:\e\Projects\9638527\utils\planrd.FUCC.dwg. 

2. Open the AutoCAD Plot tool. (ACAD: File > Plot) 

 
3. Select Adobe PDF for the Printer/Plotter. 

4. Toggle On the Plot to File command. 

5. Toggle Off Fit to Paper under Plot Scale.  Set the scale for the drawing to 1:50. 

6. Click OK. 
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7. Name the PDF UTADRD01.pdf and place the file in the following folder: 

C:\e\Projects\9638527\utils\UTADRD01.pdf. Click OK. 

8. Open the UTADRD01.pdf and review the plot. 
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INTRODUCTION 

The objective of this chapter is to outline the procedures for relocating the existing utilities to accommodate the 
proposed roadway project. 

TRANSFERRED DATA 

The FDOT District Utilities Office will provide the Utility Agency/Owner (UAO) with all design files needed 
to review or modify existing utilities located in or near the project area.  The FDOT District Utilities Office will 
provide the UAO with the following files: 

 Existing Utilities Design File (UTEXRD01.dgn) – Design file created by the FDOT composed from 
utility design files supplied by the UAO. 

 Existing Topography Design File – Design file containing all topographic and planimetric information 
pertaining to the project. 

 Proposed Roadway Design File – Design file containing the planimetric geometry of the proposed 
roadway. 

 Proposed Drainage Design File (if applicable) – Design file containing the drainage systems for the 
project. 

 Existing and Proposed Right-of-Way Design File 

Note: All files distributed to the UAO are for reference purposes only.  The UAO is to complete all 
revisions and proposed construction in new design files. 

PROPOSED UTILITY FILE 

The UAO is responsible for creating a proposed utility design file.  The proposed utility design file will be 
named UTPRUW01.dgn.  The only information to be placed in this file is proposed utility information.  To 
create the proposed utility file, the user will make a copy of the UTEXUW01.dgn design file and rename it.   
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The utility lines within the proposed utility will be color coded to distinguish the status of the utility line.  The 
color coding system for the utility lines is referred to as the Red, Brown, Green markup procedure.  The Red, 
Brown, Green procedure requires the Designer to change the color attributes of the utility line that is placed 
using the FDOT2004 Utilities Menu.  For example, if a Water line is rerouted, the color of the line would 
change from the HotLists standard Blue to Brown.  Users may use the Markup Utility to change the attributes 
for the utilities. 

 
 

               

The “Flag” button is used to toggle between the Utility and Standard View.  

Green: Existing utility facilities to Remain in Place with no adjustment. 

Red: Existing utility facilities to be removed or relocated horizontally to some other location or existing 
facilities to be Placed Out Of Service (deactivated) but left in place. 

Brown: Existing utility facilities that are to be adjusted vertically but to remain in the same horizontal 
alignment or completely new facilities to be installed. 

The “Lock” button removes selected elements from the category. 

The “Settings” button allows the user to adjust the color and line weight setting. Permissions are required 
for this button to work in the individual workstations. 

Note: In addition to the color code, the limits of the facilities to be removed, relocated, adjusted, or 
placed out of service (deactivated) shall be delineated. If the work is associated with an FDOT 
construction project, utility delineation will be shown by station. 

EXERCISE 9.1: RED, BROWN, GREEN 

GENERATE PROPOSED PLAN - MICROSTATION 

1. Open the MicroStation file C:\e\Projects\9638527\utils\UTEXUW01.dgn. 

2. Save the file design file as UTPRUW01.dgn. (MS: File > Save As) 

3. Open the MicroStation Saved View Water. (MS: Utilities > Saved Views) 

4. Open the Potable Water HotList. (FDOT 2004 Utilities: Set Utility > Potable Water) 
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5. Select the P_Potable_Water tab. 

 
6. Click Water Line.  Draw a line from P1 to P2. 

 
7. Change the color attribute for the proposed water line from Blue to Brown by selecting the “Brown” 

button then select the proposed water line to be changed. Data point. 
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8. Change the colors of the following lines to match the appropriate attributes: 

 

 
GENERATE PROPOSED PLAN – AUTOCAD 

1. Open the AutoCAD file C:\e\Projects\9638527\utils\UTEXUW01.dwg. 

2. Save the file design file as UTPRUW01.dwg. (ACAD: File > Save As) 

3. Open the AutoCAD Named View Water. (ACAD: View > Named View) 

4. Open the Potable Water HotList. (FDOT 2004 Utilities: Set Utility > Potable Water) 

5. Select the P_Potable_Water tab. 
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6. Click Water Line.  Draw a line from P1 to P2. 

 
7. Change the color attribute for the proposed water line from Blue to Brown by selecting the “Brown” 

button then select the proposed water line to be changed. Data point. 

8. Change the colors of the following lines to match the appropriate attributes: 
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INTRODUCTION 
The objective of this chapter is to discuss the file that is to be transmitted to the FDOT District Utilities Office. 

UTILITY ADJUSTMENT FILE (PROPOSED) 
The Utility Agency/Owner (UAO) will provide the FDOT District Utilities Office with a Utility Adjustment 
File, UTPRUW01.dgn, combining all existing, proposed, and Placed Out of Service/Deactivated utility lines.  
The UAO will distribute this file to the FDOT District Utilities Office for review before it is sent to the 
Roadway Designer.  The Utility Adjustment File will be distributed as a DGN, DWG, or PDF to the FDOT 
District Utilities Office.  After final review of the plans by the FDOT District Utilities Office, the UAO will be 
contacted with any revisions necessary. 

DATA TRANSFER 
The data transfer procedure will be the same as previously discussed; see Chapter 7, Phase I-FDOT Review for 
details.  The UAO is responsible for delivering the Utility Adjustment Plans, UTPRUW01.dgn, to the FDOT 
District Utilities Office.  The Adjusted Utility Plan is required to be delivered the following ways: 

 MicroStation/AutoCAD Design File – All References/XREF must be detached. 

 One set of Utility Adjustment Plans 

 PDF of Utility Adjustment Sheets – See Chapter 8, FDOT Data Transfer for details on creating a PDF. 
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